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Chapter 1 Overview

1.1 Description

EZ-iVMS isa versatile video management software for the DVRs, NVRs, IP cameras, encoders
decoders, etc. It provides multiple functionalities, including real-time live view, video recording,
remote search and playback, file backup, etc., for the connected devices to meet the needs of
monitoring task. With the flexible distributed structure and easy-to-use operations, the client software
is widely applied to the surveillance projects of medium or small scale.

This user manual describes the function, configuration and operation steps of EZ-iVMS software. To

ensure the properness of usage and stability of the software, please refer to the contents below and

read the manual carefully before installation and operation.

1.2 Running Environment

Operating System: Microsoft Windows 7/Windows 2008(32/64-bit operating system), Windows
2003/Windows XP(32-bit operating system)

CPU: Intel Pentium IV 3.0 GHz or above

Memory: 1G or above

Display: 1024*768 or above

Notes:

®  For high stability and good performance, these above system requirements must be met.

® The software does not support 64-bit operating system; the above mentioned 64-bit operating

system refers to the system which supports 32-bit applications as well.

1.3 Function Modules

Control Panel of EZ-iVMS
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_...g Control Panel

‘Operation and Control

A

Maintenance and Management

Device Management

The management of the devices and
|\ groups: adding, deleting,and the

configuration of the resources

) B E‘. ®% NVR_IP Camera8 Failed to get stream, start reconnection. Error code iVIMS-4200.exe[302].(Camera is disabled or not connected .}

Menu Bar:
Open Captured picture Search and view the captured pictures stored on local PC.
. Open Video File Search and view the video files recorded on local PC.
File Open Log File View the backup log files.
Exit Exit the iVMS-4200 client software.
Lock Lock screen operations. Log in the client again to unlock.
System Switch User Switch the login user.

Import System Config File Import client configuration file from your computer.

Export System Config File Export client configuration file to your computer.
1024*768 Display the window at size of 1024*768 pixels.
1280*1024 Display the window at size of 1280*1024 pixels.
1440*900 Display the window at size of 1440*900 pixels.
1680*1050 Display the window at size of 1680*1050 pixels.

—_— Full Screen Display the window in full screen.
Control Panel Enter Control Panel interface.
Main View Open Main View page.
Remote Playback Open Remote Playback page.
E-map Open E-map page.
Auxiliary Screen Preview Open Auxiliary Screen Preview window.
Device Management Open the Device Management page.
Event Management Open the Event Management page.
Tool Record Schedule Open the Record Schedule page.
Account Management Open the Account Management page.

Log Search Open the Log Search page.
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System Configuration Open the System Configuration page.
Broadcast Select camera to start broadcasting.
Device Arming Control Set the arming status of devices.
1/0 Control Turn on/off the alarm output.
Player Open the player to play the video files.
Message Queue Display the information of Email message to be sent.
Open Wizard Open the guide for the client configuration.

Click to open the User Manual; you can also open the User
User Manual (F1) )
Manual by pressing F1 on your keyboard.

Help
About View the basic information of the client software.

Select the language for the client software and reboot the
Language

software to activate the settings.

The EZ-iVMS client software is composed of the following function modules:
a The Main View module provides live view of network cameras and video encoders, and

supports some basic operations, such as picture capturing, recording, PTZ control, etc.
The Remote Playback module provides the search, playback, export of record files.

The E-map module provides the displaying and management of E-maps, alarm inputs, hot
ﬁ regions and hot spots.
The Device Management module provides the adding, modifying and deleting of different
& devices and the devices can be imported into groups for management.
o ¥ The Event Management module provides the settings of arming schedule, alarm linkage

actions and other parameters for different events.
L The Record Schedule module provides the schedule settings for recording.

[ The Account Management module provides the adding, modifying and deleting of user
&l accounts and different permissions can be assigned for different users.
= The Log Search module provides the query of system log files and the log files can be
@ filtered by different types.
\! The System Configuration module provides the configuration of general parameters, file
3]

saving paths, alarm sounds and other system settings.

The function modules are easily accessed by clicking the navigation buttons on the control panel or by

selecting the function module from the View or Tool menu.

You can check the information, including current user, network usage, CPU usage, memory usage and

time, in the upper-right corner of the main page.

1.4 Updates Instruction

Multiple newly-designed functions are offered in the latest EZ-iVMS client software. You can get a

brief view of the updates instruction from the following contents.
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Embedded Web Server

With the embedded web server, EZ-iVMS client can be accessed via the web browser. And it
provides the functionalities of live view, playback, device management, account management,
system configuration, etc.

User-friendly Wizard for Operation Guide

iEZ-IVMS  client offers a user-friendly wizard and it introduces some basic operations of the
software, such as adding device, importing device to group, configuring record schedule, etc.
Different View Modes

Different view modes are supported in the live view or playback process. You can play the video
in default view mode or in custom view mode. The custom view can be customized as desired.
Camera Linkage for Tampering Alarm/Video Loss Alarm

Enable the alarm triggered pop-up image function. When tampering alarm or video loss alarm
occurs, the image from the linked camera will pop up for notification.

Offline Device Adding

The offline device can also be added to the client with the required information input. When the
device comes online, the software will connect it automatically.

Alarm Input Hot Spot

Not only the cameras, but also the alarm inputs can be added to the E-map as hot spots. The
alarm input hot spots can detect the conditions of the surveillance scenario and give the alarm

information.
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Chapter 2 Live View

2.1 User Registration and Login

For the first time to use EZ-iVMS client software, you need to register a super user for login
Steps:

1. Input the super user name and password.

2. Confirm the password.

3. Optionally, check the checkbox Enable Auto-login to log in the software automatically.
4. Click Register. Then, you can log in the software as the super user.

Register Administrator

Please create a super user before proceeding

Super User: [|

Password:
Confirm Password:

Enable Auto-login

Register Cancel

Notes:
® A user name cannot contain any of the following characters: /\: *? “<> |
® The password cannot be empty and the length of the password should be no less than six

characters.

When opening EZ-iVMS after registration, you can log in the client software with the registered user
name and password.

Steps:

1. Input the user name and password you registered.

2. Optionally, check the checkbox Enable Auto-login to log in the software automatically.

3. Click Login.

User Name: |I'0CIT o

Password:

Enable Auto-login

Login Cancel

After running the client software, a wizard will pop up to guide you to add the device and do some

basic settings.
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2.2 Adding the Encoding Device

Purpose:

After running the EZ-iVMS , devices including network cameras, video encoders, DVRs, NVRs, should
be added to the client for the remote configuration and management, such as live view, playback,
alarm settings, etc.

Perform the following steps to enter the Encoding Device Adding interface:

1. Click the g icon on the control panel,

or click Tools->Device Management to open the Device Management page.
Click the Server tab.

3. Click Encoding Device to enter Encoding Device Adding interface.

& sever |@  Group

Organization Device for Management (0)

| Encosngoeice | Add Device Wod Delete Remole Config Refresh Al Fiter

AU EhEERC VDS Nickname ~ ~ |IP Device Serial No. Net Status HDD Status Recording

Online Device (5) Refresh Every 155

Add to Client AddAll Modify Netinfo |~ Restore Default Password Filter
P | Device Type Port Device Serial No. Added

172623123  DS-2CD21321 8000 DS-2CD2132-0120130426CCRR443221281 No

DVR/DVSINVRIPCAPDAVIS-4200

Encoding device can be added: 172623105  iDS-2CD864F-EID 8000  iDS-2CDBB4F-E/D0120130307CCRR417874726  No | ‘
PCNVR/IVMS-4200 Encoding Server

172623177  DS-2CDBA4B4C-CV1 8000  DS-2CD8464C-CV10120130121CCRR416186816  No

You can add the device in the following ways:

® By detecting the online devices, see Section 2.2.1 Adding Online Devices.
® By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
® By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
® By IP Server, see Section 2.2.4 Adding Devices by IP Server.

® By HiDDNS, see Section 2.2.5 Adding Devices by HiDDNS.

2.2.1 Adding Online Devices

Purpose:
The active online devices in the same local subnet with the client software will be displayed on a list.
You can click the Refresh Every 15s button to refresh the information of the online devices.
Steps:
1. Select the devices to be added from the list.
2. Click Add to Client to open the device adding dialog box.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address. The IP address of the device is obtained automatically in

8
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this adding mode.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Adding Mode:

(@ IP/Domain IP Segment IP Server HiDDMS

Add Offline Device

Nickname: [|

Address: 172623124
Port: 8000

User Mame:

Password:
«/ Exportto Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Add Cancel

Click Add All, input the user name and password, and you can add all the online devices to the client

software.

Adding Made:

(@ IPIDomain IP Segment IP Server HIDDNS

User Name: l|

Password:
~ Exportto Group
Create group with device IF.

Add Cancel

Select the device from the list, click Modify Netinfo, and then you can modify the network
information of the selected device.
Select the device from the list, click Restore Default Password, and then you can restore the default

password of the selected device.
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2.2.2 Adding Devices Manually

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP/Domain as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address or domain name.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Add ®

Adding Mode:
2 |IP/[Domain IP Segment IP Server HIDDNS

Add Offine Device

Mickname:

Address:

Port: 8000

User Name:

Password:

~ Exportto Group

Setthe device name as the group name and add all the channels

connected to the device to the group

Add Cancel

2.2.3 Adding Devices by IP Segment

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP Segment as the adding mode.
3. Input the required information.
Start IP: Input a start IP address.
End IP: Input an end IP address in the same network segment with the start IP.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device IP. All the
channels of the device will be imported to the corresponding group by default.
5. Click Add, and the device of which the IP address is between the start IP and end IP will be added
10
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to the device list.

Adding Made:

IPiDomain (@ IP Segment IP Server HIDDNS

Add Offline Device

Start IP: [I

EndIP
Port: 8000
User Name:

Password:
~ Exportto Group
Create group with device IP.

Add Cancel

2.2.4 Adding Devices by IP Server

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select IP Server as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: Input the IP Server address.
Device ID: Input the device ID registered on the IP server.
User Name: Input the device user name. By default, the user name is admin.

Password: Input the device password. By default, the password is 12345.

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All

the channels of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Adding Mode:

IPIDomain IP Segment @ |P Server HIDDNS

Add Offline Device

Nickname: ||

ServerAddress:
Device ID:
User Name:

Password:
« Exporito Group

Setthe device name as the group name and add all the channels
connected to the device to the group.

Add Cancel

11
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2.2.5 Adding Devices by HiDDNS

Steps:
1. Click Add Device to open the device adding dialog box.
2. Select HIDDNS as the adding mode.
3. Input the required information.
Nickname: Edit a name for the device as you want.

Server Address: www.hik-online.com.

Device Domain Name: Input the device domain name registered on HiDDNS server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
5. Click Add to add the device.

Add ®
Adding Mode:
IPiDomain IP Segment IP Server # HIDDNS
Add Offine Device
Nickname: l|
ServerAddress: www.hik-online.com
Device Domain Name:
User Name:
Password:
~ Exportto Group
Setthe device name as the group name and add all the channels
connected to the device to the group
Add Cancel

Note: EZ-iVMS also provides a method to add the offline devices. Check the checkbox Add Offline
Device, input the required information and the device channel count, and then click Add. When the

offline device comes online, the software will connect it automatically.

The devices will be displayed on the device list for management after added successfully. You can
check the resource usage, HDD status, recording status, and other information of the added devices
on the list.

Click Refresh All to refresh the information of all added devices. You can also input the device name in
the filter field for search.

Select device from the list, click Modify/Delete, and then you can modify/delete the information of
the selected device.

Select device from the list, click Remote Config, and then you can do some remote configurations of

the selected device if needed.

12
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2.3 Group Management

Purpose:

The devices added can be organized into groups for a convenient management. You can get the live
view, play back the record files, and do some other operations of the device through the group.
Before you start:

Devices need to be added to the client software for group management.

Perform the following steps to enter the Group Management interface:
1. Open the Device Management page.
2. Click the Group tab to enter the Group Management interface.

4AddGroup  zDelete Group  Resources of Group IPC1

Adding the Group

Steps:
1. Click Add Group to open the Add Group dialog box.
2. Input a group name as you want.
3. Click OK to add the new group to the group list.
You can also check the checkbox Create Group by Device Name to create the new group by the

name of the selected device.

Add Group *

Group Name: H ‘[

Create Group by Device Name

OK Cancel

Importing Encoding Device to Group

Steps:

1. Click Import on Group Management interface, and then click the Encoding Channel tab to open
13
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the Import Encoding Channel page.

Select the thumbnails/names of the encoding channels in the thumbnail/list view.

Select a group from the group list.

Click Import to import the selected encoding channels to the group.

You can also click Import All to import all the encoding channels to a selected group.

Notes:

You can also click the icon

on the Import Encoding Channel page to add a new group.

Up to 64 cameras can be added to one group.

™ Encoding Channel | & Alarm Input

Select Device Al

Encoding Channel

1Pl

Import

ImportAll

The following buttons are available on the Import Encoding Channel page:

o oo

o

= !
[

\)C Q/

&«

List View
Thumbnail View
Refresh

Import

Collapse/Expand

View the encoding channel in list view.

View the encoding channel in thumbnail view.

Refresh the latest information of added encoding channels.
Create a group by device name and import the device to group.

Collapse/Expand the thumbnails of encoding channels.

Modifying the Group/Channel

Steps:

1.

2.
3.
4

Select the group/channel from the group list on the Import Encoding Channel page.

Click

, or double-click the group/channel name to open Modify Group/Camera dialog box.

Edit the group/channel information, including the group/camera name, the camera type, etc.

Click OK to save the new settings.

You can also double-click the group/channel name on the Group Management interface to open

the Modify Group/Camera dialog box.

14
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Modify Camera x

Mame: [IF'C1_CameraEl1| l
Camera Type: Main Stream ~
Group Name: [IF'C‘I ] Copyto...
oK Cancel OK Cancel

Removing Channels from the Group

Steps:

1. Select the channel from the group list on the Import Encoding Channel page.

2. Click to remove the channel from the group.
You can also select the channel on the Group Management interface, and then click Delete to

remove the channel from the group.

Select the group from the group list on the Import Encoding Channel page, and Click . You can
remove all the channels from the group.

Deleting the Group

Steps:
1. Select the group on the Group Management interface

2. Click Delete Group or click the icon and the selected group will be deleted.

2.4 Basic Operations in Live View

Purpose:

For the surveillance task, you can view the live video of the added network cameras and video
encoders on the Main View page. And some basic operations are supported, including picture
capturing, manual recording, PTZ control, etc.

Before you start:

A camera group is required to be defined for live view.

Click the a icon on the control panel,

or click View->Main View to open the Main View page.

15
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Wiew
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> &
o Feset
2 Cresen
1 Zresett

)2 -resctd

Main View Page
1 View List
2 Camera List
3 PTZ Control Panel
4 Display Window of Live View

5 Live View Toolbar

Camera Status:

") The camera is online and works properly.
a The camera is in live view.

& The camera is in recording status.
&

The camera is offline.

Live View Toolbar:

On the Main View page, the following toolbar buttons are available:

Set the screen layout mode and save the new settings for the

> Set View
current view; save the current view as another new view.
E Stop Live View Stop the live view of all cameras.
Previous Go for live view of the previous page.
Next Go for live view of the next page.
2Zi:f::v/i::ahuse Click to resume/pause the auto-switch in live view.
H Show /Hide the Menu  Show/Hide the config menu of auto-switch. Click again to hide.
E Mute/Audio On Turn off/on the audio in live view

Full Screen Display the live view in full screen mode. Press ESC to exit.

Right-click on the display window in live view to open the Live View Management Menu:
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= Stop Live View

Capture

Print Captured Picture

Send Email

Start Recording

Open Window PTZ Control
Open Digital Zoom

Switch to Instant Playback »

POy i

Start Two-way Audio
) Disable Audio

i

&

Camera Status

A

Remote Configuration
Synchronization

(4 5

Full Screen

®
&8

The following buttons are available on the right-click Live View Management Menu:

wE m

-

@ Pk 0O

E#'J "E il

i

g8 (!

o

=)

Stop Live View
Capture
Print Captured Picture

Send Email

Start/Stop Recording
Open Window PTZ
Control

Open Digital Zoom
Switch to Instant
Playback

Start/Stop Two-way
Audio
Enable/Disable Audio

Camera Status

Remote Configuration
Synchronization

Full Screen

Stop the live view in the display window.

Capture the picture in the live view process.

Capture the current picture and then print the picture.

Capture the current picture and then send an Email notification to
one or more receivers. The captured picture can be attached.
Start/Stop the manual recording. The record file is stored in the PC.
Enable PTZ control function on the display window. Click again to
disable the function.

Enable the digital zoom function. Click again to disable the function.

Switch to instant playback mode.

Click to start/stop the two-way audio of the camera in live view.

Click to enable/disable the audio in live view.

Display the status of the camera in live view, including the recording
status, signal status, connection number, etc.

Open the remote configuration page of the camera in live view.

Sync the camera in live view with the PC running the client software.

Display the live view in full screen mode. Click the icon again to exit.

2.4.1 Starting and Stopping the Live View

Starting Live View for One Camera

Steps:

1.
2.

Open the Main View page.

Optionally, click the icon in live view toolbar, then click the screen layout button and
select the screen layout mode for live view.

Click-and-drag the camera to the display window,
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or double-click the camera name after selecting the display window to start the live view.
Note: You can click-and-drag the video of the camera in live view to another display window if

needed.

Starting Live View for Camera Group

Steps:
1. Open the Main View page.
2. Click-and-drag the group to the display window,
or double-click the group name to start the live view.

Note: The display window number is self-adaptive to the camera number of the group.

Starting Live View in Default View Mode

Purpose:

The video of the added cameras can be displayed in different view modes. 4 frequently-used default

view modes are selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

Steps:

1. Openthe Main View page.

2. Click theicon '* ' to expand the default view list.

3. Click to select the default view mode, and the video of the added cameras will be displayed in a
sequence in the selected view.

Note: Right-click the current default view name on the list and click Save View As., and you can save

the default view as a custom view.

Starting Live View in Custom View Mode

Purpose:

The view mode can also be customized for the video live view.
Steps:

1. Open the Main View page.

o

2. Click the icon to expand the custom view list.

3. Click New View in the custom view list to create a new view.

4. Input the view name and click Add. The new view is of 4-Screen mode by default.

5. Optionally, Click the icon in live view toolbar, then click the screen layout button and
select the screen layout mode for the new view.

6. Click-and-drag the camera/group to the display window,
or double-click the camera/group name in custom view mode to start the live view.

7. Click the icon to save the new view.

Right-click the custom view name on the list, and a menu pops up as follows:

# EditView Name
[if Delete View

i Save View

&£, Save ViewAs.

The following buttons are available on the right-click menu:
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= Edit View Name Edit the name of the custom view.

@ Delete View Delete the custom view.

En ) Save View Save the new settings of the custom view.

=, Save View As. Save the current view as another custom view.

Stopping the Live View

Steps:

1. Select the display window.

2. Click the icon . that appears in the upper-right corner when the mouse pointer is over the
display window,
or click Stop Live View on the right-click menu to stop the live view of the display window.

You can also click the button G in live view toolbar to stop all the live view.

2.4.2 Auto-switch in Live View

Camera Auto-switch

Purpose:

The video stream of the cameras from the same group will switch automatically in a selected display
window in camera auto-switch.

Steps:

1. Open the Main View page.

2. Select a display window for camera auto-switch.

3. Click the icon H in the toolbar and select the switching interval.

4. Select a group and click the icon "2 on the group node.

5. You can click the icon /ﬂ to pause/resume the camera auto-switch.

Single View Auto-switch

Purpose:

The video of all the cameras on the camera list will switch automatically in a selected default view in
single view auto-switch.

Steps:

1. Open the Main View page.

2. Click the icon H in the toolbar and select the switching interval.

3. Select a default view and click the icon *~ on the selected view node.

4

You can click the icon /ﬂ to pause/resume the single view auto-switch.
Multi-view Auto-switch

Purpose:
The custom views will switch automatically in multi-view auto-switch. The custom views need to be
added before proceeding.
Steps:
1. Open the Main View page.
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2. Click the icon H in the toolbar and select the switching interval.
3. Clicktheicon "2 on the custom view node.
4. You can click the icon /ﬂ to pause/resume the multi-view auto-switch.

2.4.3 PTZ Control in Live View

The software provides PTZ control for cameras with pan/tilt/zoom functionality. You can set the preset,
patrol and pattern for the cameras on the PTZ Control panel. And you can also open window PTZ
control for the operations of PTZ cameras.

Click the icon ™ to expand the PTZ Control panel.
PTZ Control v

« | O |+ & -

I 4 + & -

- +
= E e I

Preset | Pattern | Patrol |

> F I
01 Presett ]
02  Preset2 ‘ ‘
03  Preset 1
04 Presetd4

The following buttons are available on the PTZ Control panel:

Q. Zoom
Yy Focus
Q Iris

i Auxiliary Focus
3D Positioning

kd Light

0\ 2 Wiper

i Lens Initialization

Configuring the Preset

A preset is a predefined image position which contains information of pan, tilt, focus and other
parameters.

Perform the following steps to add a preset:

1. Click the Preset button to enter the PTZ preset configuration panel.

Click the direction buttons on the PTZ control panel to steer the camera to the desired view.

Select a PTZ preset number from the preset list and click E?.
Input the name of the preset in the pop-up dialog box.

vk wN

Click OK to save the settings.
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To call a configured preset, double-click the preset, or select the preset and click the icon .
To modify a configured preset, select the preset from the list and click the icon 2

To delete a configured preset, select the preset from the list and click the icon o
PTZ Control W

s v 4 + =
- +
= E e W I
F’resekl Pattern | Patrol | Add Preset
> B W
011 | Mame: [
02 Preset2 ‘ ‘
03 Preset3 1 OK Cancel
04 Presetd K

Configuring the Pattern

A pattern is a memorized, repeating series of pan, tilt, zoom, and preset functions.
Perform the following steps to add a pattern:

1. Click the Pattern button to enter the PTZ pattern configuration panel.

2. Click (¢ to start recording of this pattern path.

3. Use the direction buttons to control the PTZ movement.

4. Click @ to stop and save the pattern recording.

5. Clicktheicon # to call the pattern. To stop calling the pattern, click =..

Note: Only one pattern can be configured, and the newly-defined pattern will overwrite the previous

one.
PTZ Control W

' v 4 + =
- +
w B e W
Preset | F'atterE} | Patrol |

r = 0@

Configuring the Patrol

A patrol is a scanning track specified by a group of user-defined presets, with the scanning speed

between two presets and the dwell time at the preset separately programmable.
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Before you start:
Two or more presets for one PTZ camera need to be added.

Perform the following steps to add and call a patrol:

1. Click the Patrol button to enter the PTZ patrol configuration panel.

2. Select a track number from the drop-down list.

3. Click "r to add a preset, and set the dwell time and patrol speed for the preset.
4. Repeat the above operation to add other presets to the patrol.

5. Optionally, you can click & or B to edit or delete a preset in the patrol path.
6. Clicktheicon # to call the patrol. To stop calling the patrol, click =..

Notes:

® Up to 16 patrols can be configured.

® The preset dwell time can be set to 1~255 sec, and the patrol speed can be set to level 1~40.

PTZ Control v
v ry v + QO -
« ) » B + ||k | -
- v 4 + 0 =

= + Add Patrol No %

2R e

Preset | Pattern | Patrol | Preset: 1 v
o v » = Dwell Time(s): |f -

Patrol Speed: 1

OK Cancel

2.4.4 Manual Recording and Capture

Toolbar in Each Live View Display Window:

In each live view display window, the following toolbar buttons are available:

Capture Capture the picture in the live view process.

u Start/Stop Recording  Start/Stop manual recording. The record file is stored in the PC.
Switch to Instant

© Switch to the instant playback mode.
Playback

Manual Recording in Live View

Purpose:

Manual Recording function allows you to record the live video on the Main View page manually and
the record files are stored in the local PC.

Steps:

1. Move the mouse pointer to the display window in live view to show the toolbar.

2. Click O in the toolbar of the display window or on the right-click Live View Management Menu
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to start the manual recording. The icon O turns to E

3. Click the icon B to stop the manual recording.
A prompt box with the saving path of the video files you just recorded will pop up if all the
operations succeed.

Notes:

® During the manual recording, an indicator ﬂ appears in the upper-right corner of the display
window.

® The saving path of video files can be set on the System Configuration interface. For details, see

Section 7.2.2 File Saving Path Settings.

Viewing Local Record Files

Steps:

1.

2
3.
4

Click File->Open Video File to open the Record Files page.

Select the camera to be searched from the Camera Group list.

Click the icon E‘_E to specify the start time and end time for the search.

Click Search. The video files recorded between the start time and end time will be displayed.
Select the video file, and click Delete. You can delete the video file.

Select the video file, and click Email Linkage. You can send an Email notification with the selected
video file attached.

Select the video file, and click Save as. You can save a new copy of the video file.

Note: To send an Email notification, the Email settings need to be configured before proceeding. For

details, see Section 7.2.5 Email Settings.

Browse Record Files x

Camera Group Video Files ﬂ Delete |- Email Linkage(Max =5MB) = Save as
Search... P
= S IPc

& IPC1_Camera0d
- & IPc2

- J IPDome

& IPDome_Camerat | |
- I NVR1

& NVR1_IP Cameral

& NVR1_IP Camera2

& NVR1_IPCamera

& NVR1_Camera01

& NVR1_IP Cameras _

Start Time:
2013-04-24 00:00:00 !
End Time:

2013-04-24 23:59:59 [

Q search

Double-click the video file and the video file can be played back locally.
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Player

OdoOooao OE

00:00:09/00:03:08

The following buttons are available on the local playback page:

- B cF/aaF Display the video in cif/4cif resolution.

n Full Screen Display the local playback page in full screen mode.
“ Close Close the local playback page of the record files.

n n Pause/Play Pause/Start the playback of the record files.

n Stop Stop the playback of the record files.

n Speed Set the playback speed.

n Single Frame Play back the record files frame by frame.

Digital Zoom Enable the digital zoom function. Click again to disable.
n IEJ cEnable/Disable Audio  Click to enable/disable the audio in the local playback.
Capture Capture the picture in the playback process.

Capturing Picture in Live View

Steps:
1. Move the mouse pointer to the display window in live view to show the toolbar.

Click the icon in the toolbar of the display window or on the right-click Live View

N

Management Menu.
A small window of the captured picture will be displayed to notify whether the capturing
operation is done or not.

Note: The saving path of the captured pictures can be set on the System Configuration interface. For

details, see Section 7.2.2 File Saving Path Settings.

Viewing Captured Pictures

The pictures captured in live view are stored in the PC running the software. You can view the
captured pictures if needed.

Steps:

1. Click File->Open Captured Picture to open the Captured Picture page.

2. Select the camera to be searched from the Camera Group list.
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Click the icon ﬂ to specify the start time and end time for the search.

Click Search. The pictures captured between the start time and end time will be displayed.
Double-click the captured picture to enlarge it for a better view.

Select the captured picture, and click Print. You can print the selected picture.

Select the captured picture, and click Delete. You can delete the selected picture.

Select the captured picture, and click Email Linkage. You can send an Email notification with the
selected picture attached.

Select the captured picture, and click Save as. You can save a new copy of the selected picture.

Open Captured Picture x

GCamera Group Local Capture (&= Print © Delete Email Linkage(Max=5MB) = Saveas
Search o]
= 8 pet

&) IPC1_Camera
- S Ipc2

Looreicamet |t

+ L DWR

Start Time:
2013-05-09 00:00:00 e
EndTime:

2013-05-09 23:53:59 [

Q_ Search

2.4.5 Instant Playback

Purpose:

The record files can be played back instantly on the Main View page. Instant playback shows a passage

of the video which was remarkable, or which was unclear on the first sight. Thus, you can get an

immediate review if needed.

Before you start:

The video files need to be recorded on the storage devices, such as the SD/SDHC cards and HDDs on

the DVRs, NVRs, Network Cameras, etc., or on the storage servers.

Steps:

1. Start the live view and move the mouse pointer to the display window to show the toolbar.

2. Click the icon in the toolbar and a list of time periods pops up.
30s, 1 min, 3 min, 5 min, 8 min, and 10 min are selectable.

3. Select a time period to start the instant playback.
Example: If the current time of the live view is 09:30:00, and you select 3 min, then the instant
playback will start from 09:27:00.

4. Click theicon again to stop the instant playback and go back for the live view.

Notes:

® During the instant playback, an indicator E appears in the upper-right corner of the display
window.

® The live view process will continue after the instant playback completed.
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Right-click on the display window to open the Instant Playback Management Menu:

44 Pause

= Stop

»» SpeedUp

<« SpeedDown

1» Single Frame

&_ Open Digital Zoom

m@j Capture

(= Print Captured Picture
» Send Email

© startRecording

2 Enable Audio

@ Switch to Live View

&

& Full Screen

25

The following buttons are available on the right-click Instant Playback Management Menu:

sl =]

7|

]

W § BN

G.A

00
2 W)

Pause/Play

Stop

Speed Up/Down
Single Frame

Open Digital Zoom
Capture

Print Captured Picture

Send Email

Start/Stop Recording
Enable/Disable Audio
Switch to Live View
Full Screen

Pause/Start the instant playback in the display window.

Stop the instant playback and return to the live view mode.
Increase/Decrease the play speed of the instant playback.

Play back the record file frame by frame.

Enable the digital zoom function. Click again to disable the function.
Capture the picture in the instant playback process.

Capture the current picture and then print the picture.

Capture the current picture and then send an Email notification to
one or more receivers. The captured picture can be attached.
Start/Stop clipping the record files.

Click to turn on/off the audio in instant playback.

Switch to live view mode.

Display the instant playback in full screen mode. Click again to exit.
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2.4.6 Other Functions in Live View

There are some other functions supported in the live view, including digital zoom, two-way audio,

camera status and synchronization.

Auxiliary Screen Preview

The live video can be displayed on different auxiliary screens for the convenient preview of multiple

monitoring scenes. Up to 3 auxiliary screens are supported.

Digital Zoom

Use the left key of mouse to drag a rectangle area in the lower-right/upper-left direction, and then the

rectangle area will zoom in/out.

Two-way Audio

Two-way audio function enables the voice talk of the camera. You can get not only the live video but
also the real-time audio from the camera. This two-way audio can be used for only one camera at one

time.

Camera Status

The camera status, such as recording status, signal status, connection number, etc., can be detected

and displayed for check. The status information refreshes every 10 seconds.

Synchronization

The synchronization function provides a way to synchronize the live video clock with the PC which

runs the client software.
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Chapter 3 Remote Record Schedule Settings
and Playback

When the video storage devices are the HDDs, Net HDDs, SD/SDHC cards on the local device, or the
remote storage server connected, you can set the record schedule for the cameras for the continuous,
alarm triggered or command triggered recording. And the record files can be searched for the remote

playback.

3.1 Remote Recording

Purpose:
The video files can be recorded on the HDDs, Net HDDs, SD/SDHC cards on the local device, or the

storage server connected.

5
Click the =) jcon on the control panel,

or click Tool->Record Schedule to open the Record Schedule page.

Camera Group Record Schedule Copy to. I save
Search p
Local Recording
IPC1-Encoding Channel
All-day Template Edit
@ IPC1_Cameral 01

Edit
IPC2-Encoding Channel

IP Dome-Encoding Chan. Storage Server Recording
RS AT T ~ Storage Server storage senver «|  Storage Seer Management

Rec ule: All-gay Template Edit Advanced Setings

3.1.1 Recording on Storage Devices on the DVRs, NVRs, or

Network Cameras

Purpose:

Some local devices, including the DVRs, NVRs, and Network Cameras, provide storage devices such as
the HDDs, Net HDDs and SD/SDHC cards for record files. You can set a record schedule or capture
schedule for the channels of the local devices.

Note: The pictures captured through the capture schedule are stored on the local device and can be

searched on the remote configuration page of the device.
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Before you start:
The newly installed storage devices need to be formatted. Go to the remote configuration page of the
device, click Storage->General, select the HDD or SD/SDHC card, and click Format to initialize the
selected storage device.
Steps:
1. Open the Record Schedule page.
2. Select the camera in the Camera Group list.
3. Check the checkbox Record Schedule under Local Recording to enable device local recording.
4. Select the record schedule template from the drop-down list.
All-day Template: for all-day continuous recording.
Weekday Template: for working-hours continuous recording from 8:00 AM to 8:00 PM.
Alarm Template: for motion detection or alarm input triggered recording.
Template 01-08: fixed templates for specific schedules. You can edit the templates if needed.
Custom: can be customized as desired.
If you need to edit or customize the template, see Configuring Record Schedule Template.
5. Click Advanced Settings to set the recording parameters. For details, see Table 3.1 Advanced
Recording Settings.
Optionally, click Copy to... to copy the record schedule settings to other channels.

Click Save to save the settings.

Advanced Settings x

Pre-record: Ag -
Post-record: 55 v
Video Expired Time: 0 day(s}
Redundant Record: [Ma |
Record Audio: Yes v

OK Cancel

Table 3.1 Advanced Recording Settings

Parameters Descriptions

Normally used for the event triggered record, when you want to record before
Pre-record

the event happens
Post-record After the event finished, the video can also be recorded for a certain time.

. . . The time for keeping the record files in the storage device, once exceeded, the
Video Expired Time | . . .
files will be deleted. The files will be saved permanently if the value is set as 0.

Redundant Record Save the video files not only in the R/W HDD but also in the redundant HDD.

Record Audio Record the video files with audio or not.

Configuring Record Schedule Template

Perform the following steps to configure the record schedule template:
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If Template 01-08 is selected from the drop-down list, start from step 1;

If Custom is selected from the drop-down list, start from step 2.

1. Click Edit to enter the Templates Management interface. Select the template to be set and you

can edit the template na

me.

2. Set the time schedule for the selected template.

£ Schedule Recording yafer to normal schedule record. The schedule time bar is greenyellow.

£ EventRecording| rofers to the schedule record for the alarm input or motion detection event. The

schedule time bar is red.
# Command

green.

refers to the schedule record triggered by command. The schedule time bar is

Note: Record triggered by command is only available for the ATM transactions when the ATM DVR

is added to iVMS-4200.

When the cursor turns to z, you can edit the schedule time bar.

When the cursor turns to

When the cursor turns to E you can lengthen or shorten the selected time bar.

, you can move the selected time bar you just edited.

3. Optionally, you can select the schedule time bar,

and then click the icon (% to delete the selected time bar,

or click the icon ' B | to delete all the time bars,

or click the icon to copy the time bar settings to the other dates.
4. Click OK to save the settings.

You can click Save as Schedule Template on the Custom Schedule interface, and then the custom

template can be saved as template 01--08.

Note: Up to 8 time periods can be set for each day in the record schedule.

‘

All-day Template

£ Schedule R’ecnrdilr}g‘ & EventRecording & Command

Templates Management

0

Weekday Templ...

Alarm Template

Template 01

Template 02

Template 03

Template 04
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Template 06
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Custom Schedule
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3.1.2 Recording on Storage Server

Purpose:

The storage server performs as a NVR installed on the PC. The record files can be stored in the storage
server and you can search the files for remote playback.

Before you start: .

The storage server application software needs to be installed and it is packed in the EZ-iVMS
software package. When installing the EZ-iVMS , check the checkbox Storage Server to enable the
installation of storage server.

Adding the Storage Server

Steps:

1. Click the shortcut icon @& v on the desktop to run the storage server.

Note: You can also record the video files on the storage server installed on other PC.
Open the Device Management page and click the Server tab.

Click Add New Device Type, select Storage Server and click OK.

Click Storage Server on the list to enter the Storage Server Adding interface.
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Organization Device for Management (0)

&8 Encoding Device Add Device Madif Delste Remote Config Filter

Add New Device Type

Online Device (1) Refresh Every 155
Addto Client Add All Modify Netinfo | | Restore Default Password Filter

P + | Device Type Port Device Serial No. Added

172623108  STORAGE-SERVER 8000  DS-NVR-V120B20130415-047D7BEF2FAQ No

Storage device can be added:
CVR/IVMS-4200 Storage Server

You can add the storage server in the following ways:

® By detecting the online devices, see Section 2.2.1 Adding Online Devices.

® By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
® By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
® By IP Server, see Section 2.2.4 Adding Devices by IP Server.

Formatting the HDDs

The HDDs of the storage server need to be formatted for the record file storage.

Steps:

1. Select the added storage server from the list and click Remote Config.

2. Click Storage->General, to enter the HDD Formatting interface.

3. Select the HDD from the list and click Format. You can check the formatting process from the
process bar and the status of the formatted HDD changes from Raw to Normal Status.

Note: Formatting the HDDs is to pre-allocate the disk space for storage and the original data of the

formatted HDDs will not be deleted.

Configure HDD parameters.

[m HDD No. | Capacity(MB) Free Space(MB) Status Type
11 321 1411 Raw Local
2 40479 40389 Raw Local
13 334908 310167 Raw Laocal
14 15999 7245 Raw Laocal
15 1092294 637474 Raw Laocal

Configuring Storage Server Record Schedule

Before you start:
The storage server needs to be added to the client software and the HDDs need to be formatted for

the record file storage.

Steps:
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1. Open the Record Schedule page.
2. Select the camera from the Camera Group list.
3. Check the checkbox Storage Server to enable recording on storage server.
4. Select the storage server from the drop-down list.
5. Select the record schedule template from the drop-down list.
If you need to edit or customize the template, see Configuring Record Schedule Template.
6. Click Advanced Settings to set the pre-record time, post-record time and video expired time.

Click Save to save the settings.

3.2 Remote Playback

Purpose:
The record files stored on the local device or the storage server can be searched by custom view,

camera or triggering event, and then can be played back remotely.

P

)

Click the &= icon on the control panel,

or click View->Remote Playback to open the Remote Playback page.
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Remote Playback Page

1 View List, Camera List and Event List
2 Calendar

3 Search Options

4 Search Result List

5 Display Window of Playback

6 Playback Toolbar

7 Timeline
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3.2.1 Normal Playback

Purpose:

The record files can be searched by custom view, camera or triggering event for the Normal Playback.

Searching Record Files for Normal Playback

Steps:
1. Open the Remote Playback page.
2. Click ™ to expand the View List or Camera List on the left-side.
3. Select the view or camera to be searched from the list.
4. Select the day to be searched on the calendar.
You can also click ® to show more search options, and then click the icon ﬂ to specify the
start time and end time for the search.
5. Click Search. The record files of the selected view or camera will be displayed on the Search
Result list. You can filter the results through the Filter text field.
Notes:
® You can also search the record files by the card number (only applicable to ATM DVR) or by the
file type.
® If there are record files for that camera in that day, in the calendar, the icon for that day is
displayed as | 2.. Otherwise it is displayed as | 2.
® Up to 16 cameras can be searched simultaneously.
Search Result L
Filter
- @ IPC1_Cameral
B 2013-05-00 09:12:02
B 2013-05-09 10:08:13
B 2013-05-09 11:04:50
B 2013-05-09 11:58:35
B 2013-05-00 12:44:29
B 2013-05-09 13:33:12

B 2013-05-09 14:13:18

Normal Playback

After searching the record files for the normal playback, you can play back the record files in the
following two ways:
®  Playback by File List
Select the record file from the search result list, and then click the icon ﬂ in the toolbar,
or double-click the record file to play the video on the display window of playback.
® Playback by Timeline
The timeline indicates the time duration for the record file, and the record files of different types
are color coded. Click on the timeline to play back the video of the specific time.
You can click [l or ==l to scale up or scale down the timeline bar.
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You can click L%l or L] to go to the previous or the next time period.
You can use the mouse wheel to zoom in or zoom out on the timeline.

Normal Playback Toolbar:

On the Normal Playback page, the following toolbar buttons are available:

Async/Sync Playback  Click to play back the record files synchronously/asynchronously.

E Stop Playback Stop the playback of all cameras.

m Pause/Start Playback Pause/Start the playback of the record files.

Single Frame Play back the record files frame by frame.

E n Volume Click to turn on/off the audio and adjust the audio volume.

= Full Screen Display the video playback in full screen mode. Press ESC to exit.

Note: You can move the slider on the Playback Speed Bar to set the playback speed.

3.2.2 Event Playback

Purpose:
The recordings triggered by motion detection or alarm input can be searched for Event Playback and

this function requires the support of the connected device.

Searching Record Files for Event Playback

Steps:

1. Open the Remote Playback page.

2. Click  to expand the Event List on the left-side.

3. Click Motion Detection or Alarm Input, and select the cameras or alarm input sensors.

4. Select the day to be searched on the calendar.
You can also click ¥ to show more search options, and then click the icon ﬂ to specify the
start time and end time for the search.

5. Click Search. The recordings from the selected cameras and sensors triggered by motion
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detection or alarm input will be displayed on the Search Result list.

Event Playback

After searching the recordings triggered by the event, you can play back the record files in the
following two ways:
®  Playback by File List
Select the record file from the search result list, and then click the icon in the toolbar,
or double-click the record file to play the video on the display window of playback.
® Playback by Timeline
The timeline indicates the time duration for the record file. Click on the timeline to play back the
video of the specific time.
You can click sl or IEE==ll to scale up or scale down the timeline bar.
You can click L‘J or L’J to go to the previous or the next time period.
You can use the mouse wheel to zoom in or zoom out on the timeline.

Event Playback Toolbar:

On the Remote Playback page, the following toolbar buttons are available:

E Stop Playback Stop the playback of all channels.

m Pause/Start Playback Pause/Start the playback of record files.

Single Frame Play back the record files frame by frame.

. Previous Event Go to the playback of the previous event.

. Next Event Go to the playback of the next event.

@ Volume Click to turn on/off the audio and adjust the audio volume.

= Full Screen Display the video playback in full screen mode. Press ESC to exit.

You can move the slider on the Playback Speed Bar to set the playback speed.

3.2.3 Synchronous Playback

Purpose:
In synchronous playback, the record files can be played back in synchronization.

Note: Record files from up to 16 cameras can be played back simultaneously.

Synchronous Playback for Some Searched Cameras

Steps:
1. Start the normal playback of the searched cameras.

2. Click in the toolbar, and then the record files in normal playback will be played in sync. The
icon turns to E

3. To disable the synchronous playback, click the icon E

Synchronous Playback for All Searched Cameras

Steps:
1. Search the record files for the normal playback.
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Click in the toolbar to enable the synchronous playback. The icon turns to .

Select the record file from the list and click ,
or click on the timeline to start the synchronous playback for all searched cameras.

To disable the synchronous playback, click the icon .
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Chapter 4 Event Management

Purpose:

In EZ-iVMS client software, rules can be set up for triggers and linkage actions. You can assign

linkage actions to the trigger by setting up a rule. For example, when motion is detected, an audible

warning appears or other linkage actions happen.

|

Click the ! icon on the control panel,

or click Tool->Event Management to open the Event Management page.

"§ CameraEvent A5 Alarm input Device Exception
Camera Group Select Event Type: Motion Detection ~ IPC2_Camera1 Event Configuration Copyto. = save
b2l ¥ Enable
|PC1-Encoding Channel Arming Schedule: All-day Template v Edit
@ IPC1_Camera01 Arming Region

IPC2-Encoding Channel
2]

~J IP Dome-Encoding Channel

# Sensitivity

& 1P Dome_Camera1
+ ) NVR1-Encoding Channel

DVR-Encoding Channel

Trigger Alarm Output + Trigger Channel Record « Trigger ClientAction
¥ Camera01  Audible Warning
 Email Linkage
/ Alarm on E-map
¥ Alarm Triggered Pop-up Image

+ Alarm Triggered Video Wall Di

You can set different linkage actions for the following triggers:

Motion Detection
Tampering Alarm
PIR Alarm

Video Loss

Alarm Input

Device Exception

4.1 Configuring Motion Detection Alarm

Purpose:

A motion detection alarm is triggered when the client software detects motion within its defined area.

The linkage actions, including alarm output, channel record and client action can be set.

Steps:

1.

2
3.
4

Open the Event Management page and click Camera Event tab.

Select the camera to be configured and select Motion Detection as the event type.
Check the checkbox Enable to enable the function of motion detection.

Select the arming schedule template from the drop-down list.

All-day Template: for all-day continuous arming.

Weekday Template: for working-hours continuous arming from 8:00 AM to 8:00 PM.
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Template 01-09: fixed templates for special schedules. You can edit the templates if needed.
Custom: can be customized as desired.
If you need to edit or customize the template, see Configuring Arming Schedule Template.

5. Click-and-drag the mouse to draw a defined area for the arming region.
You can click the icon = = to set the whole video area as detection area, or click the icon ﬂ to
clear all the detection area.

6. Drag the slider on the sensitivity bar to adjust the motion detection sensitivity. The larger the
value is, the more sensitive the detection is.

7. Check the checkboxes to activate the linkage actions. For details, see Table 4.1 Linkage Actions for
Motion Detection Alarm.
Optionally, click Copy to... to copy the event parameters to other channels.

9. Click Save to save the settings.

SelectEventType:  Mofion Defection | v IPC2_Camerat Event Configuraton copyo i save

< Enable

Arming Schedule: All-day Template v Edit

Arming Region

Sensitivity:

Trigger Alarm Output ¥ Trigger Channel Record ¥ Trigger ClientAction
« Camera01 + Audible Warning
¥ Email Linkage
~/ Alarm on E-map
' Alarm Triggered Pop-up Image

 Alarm Triggered Video Wall Di...

Table 4.1 Linkage Actions for Motion Detection Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the
Alarm Output .
external device connected to the port can be controlled.

Channel Record Start the recording of the selected cameras when alarm is triggered.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.
Alarm on E-map Display the alarm information on the E-map.
Alarm Triggered The Image with alarm information pops up when alarm is triggered.

Pop-up Image

Alarm Triggered Display the video on the Video Wall when alarm is triggered.
Video Wall Display

Configuring Arming Schedule Template

Perform the following steps to configure the arming schedule template:

If Template 01-09 is selected in the drop-down list, start from step 1;
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If Custom is selected in the drop-down list, start from step 2.

Steps:

1. Click Edit to enter the Templates Management interface. Select the template to be set and you

can edit the template name.

2. Set the time schedule for the selected template.

When the cursor turns to - you can edit the schedule time bar.

When the cursor turns to m, you can move the selected time bar you just edited.
When the cursor turns to _“', you can lengthen or shorten the selected time bar.

3. Optionally, you can select the schedule time bar,

and then click the icon | % to delete the selected time bar,

or click the icon ' B | to delete all the time bars,

or click the icon to copy the time bar settings to the other dates.
4. Click OK to save the settings.
You can click Save as Schedule Template on the Custom Schedule interface, and then the custom

template can be saved as template 01--09.

Note: Up to 4 time periods can be set for each day in the arming schedule template.

All-day Template

Weekday Templ
Template 02
Template 03
Template 04
Template 05
Template 06
Template 07
Template 08

Template 09

®

Templates Management
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oK Cancel
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4.2 Configuring Tampering Alarm

Purpose:
A tampering alarm is triggered when the camera is covered and the monitoring area cannot be viewed.
The linkage actions, including alarm output and client action can be set.
Steps:
1. Open the Event Management page and click the Camera Event tab.
2. Select the camera to be configured and select Tampering Alarm as the event type.
3. Check the checkbox Enable to enable the function of tampering alarm.
4. Select the arming schedule template from the drop-down list.
If you need to edit or customize the template, see Configuring Arming Schedule Template.
5. Select the triggered camera. The image or video from the triggered camera will pop up or be
displayed on the Video Wall when tampering alarm occurs.
Click-and-drag the mouse to draw a defined area for the arming region.
Drag the slider on the sensitivity bar to adjust the tampering alarm sensitivity.
Check the checkboxes to activate the linkage actions. For details, see Table 4.2 Linkage Actions for
Tampering Alarm.
9. Optionally, click Copy to... to copy the event parameters to other cameras.

10. Click Save to save the settings.

Select Event Type Tampering Alarm | IPC2_Camera1 Event Configuration Copyto i sae
+ Enable
Arming Schedule All-day Template v Edit

Trigger Camera: IPC1_Camera01 v

Arming Region

Trigger Alarm Output + Trigger ClientAction

v Audible Warning
~ Email Linkage

¥/ Alarm on E-map

+ Alarm Triggered Pop-up Im

Table 4.2 Linkage Actions for Tampering Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the
Alarm Output .
external device connected to the port can be controlled.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.
Alarm on E-map Display the alarm information on the E-map.
Alarm Triggered The Image of the triggered camera pops up when alarm is triggered.

Pop-up Image
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Video Wall Display

Alarm Triggered

Display the video of the triggered camera on the Video Wall when alarm is

triggered.

4.3 Configuring PIR Alarm

Purpose:

A PIR (Passive Infrared) alarm is triggered when an intruder moves within the detector's field of view.

The heat energy dissipated by a person, or any other warm blooded creature such as dogs, cats, etc.,

can be detected.

Note: The PIR Alarm function requires the support of connected device.

Open the Event Management page and click the Camera Event tab.

Select the camera to be configured and select PIR Alarm as the event type.

Check the checkbox Enable to enable the function of PIR alarm.

Input a descriptive name of the alarm.

Check the checkboxes to activate the linkage actions. For details, see Table 4.3 Linkage Actions for

Optionally, click Copy to... to copy the event parameters to other channels.

Steps:
1.
2
3
4.
5
PIR Alarm.
6.
7.

Click Save to save the settings.

Alarm Name:

Select Event Type: PIR Alarm ~ IPC1_Camera01 Event Configuration Copy to & save

+ Enable

f |

TriggerAlarm Qutput « Trigger Channel Record + Trigger ClientAction

< Camera01 + Audible Warning
+/ Email Linkage
~/ Alarm on E-map
¥ Alarm Triggered Pop-up Image

+/ Alarm Triggered Video Wall Di.

Table 4.3 Linkage Actions for PIR Alarm

Linkage Actions

Descriptions

Alarm Output

Enable the alarm output function. Select the alarm output port and the

external device connected to the port can be controlled.

Channel Record

Start the recording of the selected cameras when alarm is triggered.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map

Display the alarm information on the E-map.
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Alarm Triggered The Image with alarm information pops up when alarm is triggered.

Pop-up Image

Alarm Triggered Display the video on the Video Wall when alarm is triggered.
Video Wall Display

4.4 Configuring Video Loss Alarm

Purpose:

When the client software cannot receive video signal from the front-end devices, the video loss alarm

will be triggered. The linkage actions, including alarm output and client action can be set.

Steps:

1. Open the Event Management page and click Camera Event tab.

2. Select the camera to be configured and select Video Loss as the event type.

3. Check the checkbox Enable to enable the function of video loss alarm.

4. Select the arming schedule template from the drop-down list.
If you need to edit or customize the template, see Configuring Arming Schedule Template.

5. Select the triggered camera. The image or video from the triggered camera will pop up or be
displayed on the Video Wall when video loss alarm occurs.

6. Check the checkboxes to activate the linkage actions. For details, see Table 4.4 Linkage Actions for
Video Loss Alarm.
Optionally, click Copy to... to copy the event parameters to other cameras.

8. Click Save to save the new settings.

Select Event Type: Video Loss « | IPC1_Camera01 Event Configuration Copyto I save
~ Enable
Arming Schedule All-day Template v Edit

Trigger Camera -

Trigger Alarm Qutput + Trigger Client Action
+ Audible Warning
+ Email Linkage
+ Alarm on E-map
/' Alarm Triggered Pop-up Image

+ Alarm Triggered Video Wall Di.

Table 4.4 Linkage Actions for Video Loss Alarm

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the
Alarm Output .
external device connected to the port can be controlled.
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Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map

Display the alarm information on the E-map.

Alarm Triggered
Pop-up Image

The Image of the triggered camera pops up when alarm is triggered.

Alarm Triggered
Video Wall Display

Display the video of the triggered camera on the Video Wall when alarm is
triggered.

4.5 Configuring Alarm Input Linkage

Purpose:

When a device's alarm input port receives a signal from an external alarm device, such as smoke

detector, doorbell, etc., the alarm input linkage actions are triggered for notification.

Before you start:

Add the alarm inputs to the client, click Import on the Group Management interface, click the Alarm

Input tab and import alarm inputs into groups for management.

Steps:

o vk wNR

Open the Event Management page and click the Alarm Input tab.
Select the alarm input channel to be configured.

Check the checkbox Enable.

Input a descriptive name of the alarm.

Set the alarm status according to the alarm input device.

Select the arming schedule template from the drop-down list.

If you need to edit or customize the template, see Configuring Arming Schedule Template.

7. Check the checkboxes to activate the linkage actions. For details, see Table 4.5 Linkage Actions for

Alarm Input.

8. Optionally, click Copy to... to copy the event parameters to other alarm inputs.

Click Save to save the settings.
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DVR_A1 Event Configuration

| Enable

Alarm Name: 1

Alarm Status Normal Open ® Normal Closed

Arming Schedule All-day Template - Edit
Trigger Alarm Qutput = Trigger Channel Record
A-=1 ~ Camera01

A>2
A3
=
D1-=1

D1->2

Camera02
Camera03
Camera04
Camera05
Camera0&
Camera07
Camera03
Camera09
Cameral0
Camerail
Cameral2
Camerai3

Cameral4

-/

B

L
L%
4

&

Copyto I save

Trigger Client Action

Audible Warning

Email Linkage

Alarm on E-map

Alarm Triggered Pop-up Image

Alarm Triggered Video Wall Di..

Table 4.5 Linkage Actions for Alarm Input

Linkage Actions

Descriptions

Alarm Output

Enable the alarm output function. Select the alarm output port and the

external device connected to the port can be controlled.

Channel Record

Start the recording of the selected cameras when alarm is triggered.

Audible Warning

The client software gives an audible warning when alarm is triggered.

Email Linkage

Send an Email notification of the alarm information to one or more receivers.

Alarm on E-map

Display the alarm information on the E-map.

Alarm Triggered
Pop-up Image

The Image with alarm information pops up when alarm is triggered.

Alarm Triggered

Video Wall Display

Display the video on the Video Wall when alarm is triggered.

4.6 Configuring Device Exception Linkage

Open the Event Management page and click the Device Exception tab.

Select the device to be configured.

Select the device exception type, including HDD full, HDD exception, illegal login, etc.

Check the checkboxes to activate the linkage actions. For details, see Table 4.6 Linkage Actions for

Steps:

1.

2

3

4. Check the checkbox Enable.
5

Device Exception.

6.

Optionally, click Copy to... to copy the event parameters to other devices.

Click Save to save the settings.
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Speed Dome Event Configuration Copyto.. |.-_| Save
Exception Type: HDD Full ~
Enable
Linkage Action

Trigger Alarm Output er Client Action
A= ' Audible Wamning

A=D + Email Linkage

Table 4.6 Linkage Actions for Device Exception

Linkage Actions Descriptions

Enable the alarm output function. Select the alarm output port and the

Alarm Output )
external device connected to the port can be controlled.

Audible Warning The client software gives an audible warning when alarm is triggered.

Email Linkage Send an Email notification of the alarm information to one or more receivers.

4.7 Viewing Alarm and Event Information

. . . . . AR
The information of recent alarms and events can be displayed. Click the icon in Alarms and Events
Toolbar to show the Alarms and Events panel.

\ﬂ £ B #» Motion Detection Alarm Stop A o ¥
Index~ | Alarm Time Alarm Source Alarm Details Alarm Content Live View  Send Email | TV Wall Display  Note
2 2013-03-27 19:48:25  Encoding Device:lPC Camera: IPC_Camera1 Tampering Alarm Stop | (
2 48:15  Encoding Device:IPC Camera: IPC_Camera1 Tampering Alarm Start ‘ ‘
1 719:48:114 Encoding Device:lPC  Camera: IPC_Camera1 Trig... Motion Detection Alarm Start (] =5
m + Motion Detection v Video Exception v AlarmInput v Device Exception
On the Alarms and Events panel, the following toolbar buttons are available:
E Clear Info Clear the information of alarms and events displayed on the list.
Enable/Disable Alarm ) ) )
Click to enable/disable image pop-up when alarms occur.

Triggered Pop-up Image
m n Enable/Disable Audio Click to enable/disable the audio warning for the alarm.
= Auto Hide/Lock Click to hide automatically/lock the Alarms and Events panel.
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Maximize Maximize the Alarms and Events panel in a new tab page.
E Show/Hide Click to show/hide the Alarms and Events panel.

Viewing Alarms Information

Different alarm types can be displayed on the panel: Motion Detection, Video Exception, Alarm Input

and Device Exception. You can check the checkbox to enable the displaying of that type alarm.

Before you start:

To display the alarms, the event parameters need to be configured.

Steps:

1.
2.

3.

Click the Alarm tab.

Check the checkboxes of different alarm types.

When an alarm occurs, the icon twinkles to call attention. The alarm information, including
the time, source, details and content will be displayed.

Click % to get a live view of the alarm triggered camera.

Click to send an Email notification of the alarm to one or more receivers.

Click e to display the video of alarm triggered camera on the Video Wall.

Click under the Note column to input a prompt message for the alarm.

To clear the alarm information, click the icon H,or right-click on an alarm log and then click
Clear.

Viewing Events Information

Purpose:

The abnormal events of the client software, such as the live view failure, device disconnection, can

also be displayed.

Steps:

1.

Click the Event tab.
The event information, including the time and detailed description will be displayed.

To clear the event information, click the icon H,or right-click on the event log and then click
Clear.

47



User Manual of EZ-iVMS

Chapter 5 E-map Management

Purpose:
The E-map function gives a visual overview of the locations and distributions of the installed cameras
and alarm input devices. You can get the live view of the cameras on the map, and you will get a

notification message from the map when alarm is triggered.

Click the ﬁ icon on the control panel,

or click View->E-map to open the E-map page.

e

an o
Q 20 Wap
1 PR

E-map Page
1 Group List
2 Map Display Area
3 E-map Toolbar

5.1 Adding an E-map

Purpose:
An E-map needs to be added as the parent map for the hot spots and hot regions.
Steps:

Open the E-map page.

Select a group for which you want to add a map.

Click the icon & in the Map Display Area to open the map adding dialog box.

1.

2

3

4. Input a descriptive name of the added map as desired.

5. Click theicon | and select a map file from the local path.
6

Click OK to save the settings.

Notes:
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® The picture format of the map can only be *.png, *.jpg or *.bmp.

® Only one map can be added to a group.

Map Mame: Main Map1

Path: |C:/Usersizhangxiu/DesktopMa. .. | |

oK Cancel

The map added is displayed in the Map Display Area. Use the mouse wheel to zoom in or zoom out on
the map. You can click-and-drag the yellow window in the lower-right corner or use the direction
buttons and zoom bar to adjust the map area for view.

~

1PC2 s

IP Dome

NVR1 |

Click the button Edit Map or Map Preview in the E-map toolbar to enter the map editing mode or
map preview mode.

E-map Toolbar in Map Editing Mode:

Map Preview Edit Map

" A
Map Preview  Edit Map iy

On the E-map page, the following toolbar buttons are available:

LEd Modify Map Modify the map information, including the map name and file path.
m Delete Map Delete the current map.
@ Add Camera Add a camera as the hot spot on the map.
_’:’ Add Alarm Input Add an alarm input sensor as the hot spot on the map.
S Add Hot Region Add a map as the hot region on the current map.
Modify Modify the information of the selected hot spot or hot region.
Delete Delete the selected hot spot or hot region.
Clear Alarm Info Clear the alarm information displayed on the map.
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SR Back to Parent Map  Go back to the parent map.

5.2 The Hot Spot Function

Purpose:
The cameras and alarm inputs can be added on the map and are called the hot spots. The hot spots
show the locations of the cameras and alarm inputs, and you can also get the live view and alarm

information of the surveillance scenarios through the hot spots.

5.2.1 Adding Hot Spots

Adding Cameras as Hot Spots

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Click the icon ﬂ in the toolbar to open the Add Hot Spot dialog box.

3. Check the checkboxes to select the cameras to be added.

4. Optionally, you can edit hot spot name, select the name color and select the hot spot icon.

5. Click OK to save the settings. The camera icons are added on the map as hot spots and the icons
of added cameras changes from @ to € inthe group list. You can click-and-drag the camera
icons to move the hot spots to the desired locations.

You can also click-and-drag the camera icons from the group list to the map directly to add the

hot spots.

u Linked Camera Hot Spot Name Hot Spot Color Hot Spoticon  ~

+ DVR_Cameral DVR_Cameral @ creen @ ‘

+ DVR_Camera2 DVR_Camera2 @ creen @

+ DVR_Camera3 DVR_Camera3 s Green a
DVR_Camerad DVR_Camerad b Green @
DVR_Cameras DVR_Cameras b Green @
DVR_Camerat DVR_Camerab b Green @
DVR_Camera7 DVR_Camera7 b Green @
DVR_Camerag DVR_Camerad b Green @
DVR_Camerad DVR_Camerad b Green -}
DVR_Camera10 DVR_Camera10 b Green -}
DVR_Camerall DVR_Camerall b Green -}

OK Cancel

Adding Alarm Inputs as Hot Spots

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.
2. Click the icon in the toolbar to open the Add Hot Spot dialog box.

3. Check the checkboxes to select the alarm inputs to be added.
4

Optionally, you can edit hot spot name, select the name color and select the hot spot icon.
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Click OK to save the settings. The alarm input icons are added on the map as hot spots and the
icons of added alarm inputs changes from _!’-‘ to b in the group list. You can click-and-drag
the alarm input icons to move the hot spots to the desired locations.

You can also click-and-drag the alarm input icons from the alarm input list to the map directly to
add the hot spot.

‘Add Hot Spot x

Linked Alarm Input Hot Spot Name Hot Spot Color Hot Spot lcon 3
J DVR_A1 DVR_A1 el Green @

DVR_AZ DVR_AZ B creen @

DVR_A3 DVR_AZ B creen @

DVR_A4 DVR_A4 B creen @

DVR_AS DVR_AS B creen @

DVR_AG DVR_AG B creen @

DVR_AT DVR_AT il Green @

DVR_AB DVR_AB il Green @

DVR_A9 DVR_A9 il Green @

DVR_A10 DVR_A0 Wl Green @

DVR_AT1 DVR_AT1 il Green @

OK Cancel

5.2.2 Modifying Hot Spots

Purpose:

You can modify the information of the added hot spots on the map, including the name, the color, the

icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select the hot spot icon on the map and then click n in the toolbar,
or double-click the hot spot icon on the map to open the Modify Hot Spot dialog box.

3. You can edit the hot spot name in the text field and select the color, the icon and the linked
camera or alarm input.

4. Click OK to save the new settings.

To delete the hot spot, select the hot spot icon and click in the toolbar.

Modify Hot Spot x Modify Hot Spot x

Hot Spot Name DVR_Cameral Hot Spot Name: DVR_D2
Linked Camera: Linked Alarm Input.
| DVR_Camera1 | DVR_A1
DVR_Camerad ‘ ‘ DVR_AZ
DVR_Cameras I DVR_AZ
DVR_Camerab DVR_A4
DVR_Camera7? DVR_AS
DVR_Camera8d DVR_AG
DVR_Camerad DVR_AT
DVR_Cameral10 DVR_AS
DVR_Camerall DVR_AZ
DVR Camerai2 i DVR A10
Hot Spot Color: | Green ~ HotSpotlcon: @& ~ Hot Spot Color: |l Green ~ Hot Spoticon: & ~
OK Cancel OK Cancel
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5.2.3 Previewing Hot Spots

Steps:

1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.

2. Double-click the camera hot spots, and you can get the live view of the cameras.

3. If there is any alarm triggered, an icon ! will appear and twinkle near the hot spot. Click the
alarm icon, and then you can check the alarm information, including alarm type and triggering
time.

Note: To display the alarm information on the map, the Alarm on E-map functionality needs to be set

as the alarm linkage action.
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£
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Wik Forest Willowemoc i
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5.3 The Hot Region Function

Purpose:

The hot region function links a map to another map. When you add a map to another map as a hot
region, an icon of the link to the added map is shown on the main map. The added map is called child
map while the map to which you add the hot region is the parent map.

Note: A map can only be added as the hot region for one time.

5.3.1 Adding Hot Regions

Before you start:

Add another map to the group.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select an added map as the parent map.
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o v kw

Click the icon m in the toolbar to open the Add Hot Region dialog box.
Check the checkbox to select the child map to be linked.

Optionally, you can edit the hot region name, and select the hot region color and icon.
Click OK to save the settings. The child map icons are added on the parent map as the hot regions.

You can click-and-drag the child map icons to move the hot regions to the desired locations.

Add Hot Region x

Linked Map Hot Region Name Hot Region _.. Hot Region Icon
Map1 Map1 Il Green #
Map2 Map2 B Green #

OK Cancel

5.3.2 Modifying Hot Regions

Purpose:

You can modify the information of the hot regions on the parent map, including the name, the color,

the icon, etc.

Steps:

1. Click the Edit Map button in the E-map toolbar to enter the map editing mode.

2. Select the hot region icon on the parent map and then click in the toolbar,
or double-click the hot region icon to open the Modify Hot Region dialog box.

3. You can edit the hot region name in the text field and select the color, the icon and the linked
child map.

4. Click OK to save the new settings.

To delete the hot region, select the hot region icon and click Q in the toolbar.

Modify Hot Region x

Hot Region Name: Map1
Linked Map

¥ Map1

Map2

HotRegion Color. [w Green ~ Hot Region Icon: [ ~

OK Cancel
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5.3.3 Previewing Hot Regions

Steps:
1. Click the Map Preview button in the E-map toolbar to enter the map preview mode.
2. Click the hot region icon to go to the linked child map.
3. The hot spots can also be added on the hot regions.
4. You can click the icon in the toolbar to go back to the parent map.
You can also click the icon in the toolbar to clear the alarm information.
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Chapter 6 Log Management

Purpose:

The log files of the client software are stored on the local PC and can be searched for checking. 2 types

of log files are provided: client logs and server logs. The client logs refer to the log files of the client

and are stored on the local PC; the server logs refer to the log files of the connected devices and are

stored on the local device.

Click the Lui:g icon on the control panel to open the Log Search page.

Log Search Client Log Lists [% Log Fitter [ Backup Lag
@ ClientLogs
Operation Time - Name Log Type Description Device Name Device Type Group Name

SenverLogs

Start Time:
2013-05-03 00:00:00 ]
End Time:

2013-05-03 23:59:50

FE

Q, Search

Total 0 Page 11 1| Page Go

Searching Log Files

Steps:

1.

2
3.
4

Open the Log Search page.

Select the log type. If Server Logs is selected, then click to specify the device for search.

e
Click the icon LY to specify the start time and end time.

Click Search. The log files between the start time and end time will be displayed on the list.

You can check the operation time, description and other information of the logs.

Note: Up to 36000 items of logs can be displayed. Please narrow the time range or filter the log type

for search if there are too many log files.

Operation Time Name Log Type Description Device Name Device Type Group Name
2013-05-03 08:45.09 root Alarm Log Motion DetectionA... IPC2 Encoding Device IPC2
2013-05-03 08:46:43 root Alarm Log Wotion DetectionA__. IPG2 Encoding Device  IPG2
2013-05-03 08:47:30 root Alarm Log Wotion DetectionA__. IPG2 Encoding Device  IPG2
2013-05-03 08:47 .52 root Alarm Log Motion DetectionA__. IPC2 Encoding Device IPC2
2013-05-03 02:48:16 root Alarm Log Motion Detection A... IPC2 Encoding Device IPC2
2013-05-03 08:49:44 root Alarm Log Motion DetectionA... IPC2 Encoding Device IPC2
2013-05-03 08:51:03 root Alarm Log TamperingAlarm  IP Dome: Encoding Device  IP Dome
2013-05-03 08:51:03 root Alarm Log Wotion Detection A__. 1P Dome Encoding Device  IP Dome
2013-05-03 08:51:49 root Alarm Log Motion DetectionA__. IPC2 Encoding Device IPC2
2013-05-03 08:52.08 root Alarm Log Motion Detection A... IPC2 Encoding Device IPC2
2013-05-03 08:53.25 root Alarm Log Motion DetectionA... IPC2 Encoding Device IPC2
2013-05-03 08:54:48 root Alarm Log Wotion DetectionA__. IPG2 Encoding Device  IPG2
2013-05-03 08:56:03 root Alarm Log Wotion DetectionA__. IPG2 Encoding Device  IPG2
2013-05-03 08:56:05 root Alarm Log Tampering Alarm IP Dome Encoding Device IP Dome
2013-05-03 08:56.06 root Alarm Log Motion Detection A... IP Dome Encoding Device IP Dome
2013-05-03 08:57.46 root Alarm Log Motion DetectionA... IPC2 Encoding Device IPC2
2013-05-03 08:58:04. root Alarm Log Wotion DetectionA__. IPG2 Encoding Device  IPG2
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Filtering Log Files

Purpose:

After searched out successfully, the log files can be filtered by the keyword or condition, and thus you

can find the logs as you want.

Steps:

1. Click Log Filter or the icon "= on the Log Search page to expand the Log Filter panel.

2. Select Filter by Keyword, and then input keyword for filtering in the text field; or
select Filter by Condition, and then specify log information in the drop-down list.
Optionally, you can click More... to filter the log files more accurately.

4. Click Filter to start filtering. You can click Clear Filter the clear the filtering.

Server Log Lists [# Log Filter (5 Backup Log
Filter by Keyword: Clear Filter

@ Filter by Condition: :
i More...

Major Type: e Filter

Minor Type: -

Backing up Log Files

Purpose:

The log files, including the client logs and server logs, can be exported for backup.

Steps:

1.

2
3.
4

Select the log file from the list after searching out the log files.

Click Backup Log to open the Backup Log dialog box.

Click theicon | and select a local saving path.
Click Backup to export the selected log file for backup.

You can click File>Open Log File to check the information of the backup log files on local PC.

Backup Log. x

Saving Path:

Backup Cancel
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Chapter 7 Account Management and System

Configuration

7.1 Account Management

Purpose:

Multiple user accounts can be added to the client software, and you are allowed to assign different

permissions for different users if needed.

-

Click the @™ icon on the control panel,

or click Tool->Account Management to open the Account Management page.

User List Add User Edit User Delete User

Index Name Type

1 root Super User

Note: The user account you registered to log in the software is set as the super administrator.

Adding the User

Steps:

1. Open the Account Management page.

2. Click Add User to open the Add User dialog box.

3. Select the user type from the drop-down list. 2 types of user accounts are selectable:
Administrator: The administrator account has all permissions by default, and can modify the
passwords and permissions of all operators and its own account.

Operator: The operator account has no permission by default and you can assign the permissions
manually. An operator can only modify the password of its own account.

4. Input the user name, password and confirm password as desired.

5. Check the checkboxes to assign the permissions for the created user.

6. Optionally, you can click Default Permission to restore the default permissions of this user.

7. Click Save to save the settings.

Notes:

® A user name cannot contain any of the following characters: /\ : * ? “ <> |. And the length of the
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password cannot be less than 6 characters.

® Up to 50 user accounts can be added for the client software.

Add User x

User Information

User Type: Administrator ~ User Name:

Password: Confirm Password

User Live View related

< All | & @ IPct

+ Live View + IPC1_Cameral
~/ PTZ Control +| ¥ IPC2

+/ Capture + | DVR

L4

Record + + IPDome

LY

Camera Settings

&

Play Back Remote Record File(s)

LY

Download Remote Record File(s)

L

Remaote Recording

LY

Two-way Audio

L

8ynchronization

LY

Picture Backup

Default Permission Save

Managing the User

Purpose:

After created successfully, the user account is added to the user list on the Account Management page.
You can edit or delete the information of the user accounts.

To edit the information of the user, select the user from the list, and click Edit User.

To delete the information of the user, select the user from the list, and click Delete User.

7.2 System Configuration

Purpose :
The general parameters, file saving paths, keyboard and joystick shortcuts, alarm sounds and Email

settings can be configured.

| |
Click the —=%&% icon on the control panel,

or click Tool->System Configuration to open the System Configuration page.
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System Configuration x

% General

£y File

n Alarm Sound

Email

-
Y Keyboard and Joystick

B
Set frequently used parameters

(Log expired time, display scale, play performance, etc.)

Log Expired Time AMonth -
View Scale Full Screen ~
Network Performance [Normal | | Better | | Best |

Play Performance Real Time -

+ Enable Screen Toolbar Display

| | Enable Auto-login

+/ Prioritize the Playback of Record Files on Storage Server
/| Resume Live View Status

+/ Auto-change Stream Type

Auto Time Adjustment 00:00:00

Default Value Save

Note: You can click Default Value to restore the defaults of all the system configurations.

7.2.1 General Settings

Purpose:

The frequently-used parameters, including the log expired time, view scale, etc., can be set.

Steps:

1. Open the System Configuration page.

Click the General tab to enter the General Settings interface.

2
3. Configure the general
4

parameters. For details, see Table 7.1 General Parameters.

Click Save to save the settings.

Set frequently used parameters
(Log expired time, display scale, play performance, etc.)

Log Expired Time AMonth -
View Scale: Original Resolution ~
Network Performance |Normal | | Better | |Best|

Play Performance: Real Time ~

~ Enable Screen Toolbar Display

Enable Auto-login

<

Prioritize the Playback of Record Files on Storage Server

Resume Live View Status

<

Auto-change Stream Type

&

Auto Time Adjustment 00:00:01

Table 7.1 General Parameters

Parameters

Descriptions

Log Expired Time

The time for keeping the log files, once exceeded, the files will be deleted.

View Scale

The view scale of the video in live view or playback. It can be set as Full
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Screen, 4:3, 16:9 or Original Resolution.

Network Performance

The current network conditions. It can be set as Normal, Better or Best.

Play Performance

The play performance of the live video. It can be set as Shortest Delay, Real

Time, Balanced or Fluency.

Enable Screen Toolbar
Display

Show the toolbar on each display window in live view or playback.

Enable Auto-login

Log in the client software automatically.

Prioritize the Playback
of Record Files on
Storage Server

Play back the video files recorded on the storage server preferentially.

Otherwise, play back the video files recorded on the local device.

Resume Live View
Status

Resume the latest live view status after you log in the client again.

Auto-change Stream

Type

Change the stream type automatically in live view according to the size of

the display window.

Auto Time Adjustment

Adjust the time automatically at a specified time point.

7.2.2 File Saving Path Settings

Purpose:

The video files from manual recording, the captured pictures and the system configuration files are

stored on the local PC. The saving paths of these files can be set.

Steps:

1. Open the System Configuration page.

Click the File tab to enter the File Saving Path Settings interface.

2
3. Click the icon
4

and select a local path for the files.

Click Save to save the settings.

Set file saving path
(e.g. record files, pictures and device configuation files, etc.)

Saving Path of Video File
C:fivms4200ivideo!

Saving Path of Pictures:
C:fivms4200/capture/

Saving Path of Configuration File

C:livms4200iconfig!
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7.2.3 Keyboard and Joystick Shortcuts Settings

Purpose:

DS-1003 keyboard can be connected to the client and be used to control the PTZ cameras. You can set
the shortcuts of PC keyboard and USB joystick to get quick and convenient access to the commonly
used actions.

Steps:

1. Select the COM port from the drop-down list if 1003K keyboard is connected.

2. Select a certain function from the list.

3. Double-click the item field under the PC Keyboard or USB Joystick column.

4. Select the compound keys operation or USB joystick operation from the drop-down list.

5

Click Save to save the settings.

Configure 1003K keyboard COM.
PC keyboard and USB joystick shortcuts, stc

1003K COM Joystick:  [NULL ~|

0' Setup shortcuts of PC keyboard and USB joystick for frequently used functions ofthe system.

Index Function PC Keyboard USB Joystick
1 Capture Ctrl + Print Screen ‘ ‘
2 Speedup
3 Speed down
4 Focus (+) Ctrl + Home
5 Focus () Ctrl +End
B ZoomIn(+) Ctrl ++
7 Zoom Qut (-) Ctrl + -
8 IRIS (+) Ctrl + Page Up
9 IRIS (-) Ctrl + Page Down

7.2.4 Alarm Sound Settings

Purpose:
When the alarm, such as motion detection alarm, video exception alarm, etc., is triggered, the client

can be set to give an audible warning and the sound of the audible warning can be configured.

Steps:

1. Open the System Configuration page.

2. Click the Alarm Sound tab to enter the Alarm Sound Settings interface.

3. Clicktheicon |7 and select the audio files from the local path for different alarms.
4. Optionally, you can click the icon * ! fora testing of the audio file.

5. Click Save to save the settings.

Note: The format of the audio file can only be *wav.
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Set alarm sound
(e.g. motion detection alarm,video exception alarm, alarm input and device exception alarm)

Motion Detection:

|motion wav - 9

Video Exception:

video_abnormal wav - ¥4
Alarm Input.

alarm_input.wav || g
Device Exception

device_abnormal wav - || 9

7.2.5 Email Settings

Purpose:

An Email notification can be sent when a system alarm occurs. To send the Email to some specified

receivers, the settings of the Email need to be configured before proceeding.

Steps:
1. Open the System Configuration page.
2. Click the Email tab to enter the Email Settings interface.
3. Input the required information.
SMTP Server: Input the SMTP Server address.
Port: Input the communication port of Email service. The port is 25 by default.
User Name: Input the user name of the sender Email address.
Password: Input the password of the sender Email address.
Sender Address: Input the Email address of the sender.
Receiver 1—3: Input the Email address of the receiver. Up to 3 receivers can be set.
4. Optionally, you can check the checkbox Enable SSL to increase the security of email sending.

Optionally, you can click Send Test Email to send an email to the receiver for test.

Click Save to save the settings.

Set email parameters including sender and recipient

SMTP Server:
Port: 25
User Name:

Password
SenderAddress:
Receiver 1
Receiver 2

Receiver 3
Enable SSL

Send Test Email
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Chapter 8 Forwarding Video Stream through

Stream Media Server

Purpose:
There is always a limit of the device remote access number. When there are many users wanting to get
remote access to the device to get the live view, you can add the stream media server and get the

video data stream from the stream media server, thus to lower the load of the device.

8.1 Adding the Stream Media Server

Before you start:

The stream media server application software needs to be installed and it is packed in the iVMS-4200
software package. When installing the iVMS-4200, check the checkbox Stream Media Server to
enable the installation of stream media server.

Steps:

1. Click the shortcut icon [@#% on the desktop to run the stream media server.

Note: You can also forward the video through the stream media server installed on other PC.
Open the Device Management page and click the Server tab.
Click Add New Device Type, select Stream Media Server and click OK.
Click Stream Media Server on the list and then click Add Device.
You can add the stream media server in the following two ways:
® Adding Stream Media Server Manually
Perform the following steps to add the stream media server manually:
1) Select IP Address as the adding mode.
2) Input the nickname and IP address of the stream media server. The default port value is
554.

3) Click Add to add the stream media server to the client software.

Adding Mode:

@ |PAddress IP Segment

Nickname [ ]
IP Address

Port: 554

Add Cancel

® Adding Stream Media Server by IP Segment
Perform the following steps to add the stream media server by IP segment:
1) Select IP Segment as the adding mode.
2) Input the start IP and end IP. The default port value is 554.
3) Click Add to add the stream media server to the client software.
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Adding Mode

IP Address @ |P Segment

Start IP: [I

End P

Port 554

Add Cancel

Notes: For one client, up to 16 stream media servers can be added.

8.2 Adding Cameras to Stream Media Server to Forward

Video Stream

Purpose:

To get the video stream of a camera via stream media server, you need to connect the camera to the

stream media server.

Steps:

1. Select the stream media server from the list.

2. Click Configure to enter the Stream Media Server Settings interface.

3. Select the cameras of which the video stream is to be forwarded via the stream media server.

4. Click OK to save the new settings.

5. Go the Main View page and start the live view of the cameras again. You can check the channel
number of the video stream forwarded through or sent from the stream media server.

Note: For one stream media server, up to 64 channels of video stream can be forwarded through it

and up to 200 channels of video stream can be sent to clients from it.

Stream Media Server

Stream Media Server Settings n . . No. of channels:

Search o] 5 About No. of

All

- = | DVR-Encoding Channel ‘ ‘

Operation Client IP Client Port Time
Enter 172.6.23.108 57898 2013-05-1009:51:25

< '@ DVR_Camera2
<~ |@ DVR_Camera3

@ DVR_Camerad
DVR_Cameras
DVR_Camera6
DVR_Camera7
DVR_Camera8
DVR_Camerad

DVR_Camera10

DVR_Camera11

OK Cancel
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Chapter 9 Decoding and Displaying Video on
Video Wall

The Video Wall module is only available when the decoding device is added to the client. It provides
the video decoding functionality, and the decoded video stream can be displayed on the Video Wall
for an attention-grabbing performance.

.
Click the L:J!J!J icon on the control panel,

or click View->Video Wall to open the Video Wall page .

Default Video Wall

Camera
Search o4
= S Po1
@ IPC1_Camera 1
+ 3 PC2
+ S DR
+ 3 1P Dome

1 Decoding Device

Layout

Third Party Devices
PTZ

'] ]

EBEEEE ==

£, Enter video Wall Config

9.1 Adding the Decoding Device

Purpose:

To display the video on the Video Wall, the decoding device needs to be added to the client.
Steps:

1. Open the Device Management page and click the Server tab.

2. Click Add New Device Type, select Decoding Device and click OK.

3. Click Decoding Device on the list to enter Decoding Device Adding interface.
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]
[}
@

Organization Device for Management (0)

&8 Encoding Device Add Device Madif Delste Remote Config Filter

B3 Storage Server

g8 Stream Media Server

Online Device (0) Refresh Every 155
Add to Client Add All Modify Netinfo | | Restore Default Password Filter

P + | Device Type Port Device Serial No. Added

Decoding device can be added
DecoderiVS-4200 Decoding Server

You can add the decoding device in the following ways:

By detecting the online devices, see Section 2.2.1 Adding Online Devices.

By specifying the device IP address, see Section 2.2.2 Adding Devices Manually.
By specifying an IP segment, see Section 2.2.3 Adding Devices by IP Segment.
By IP Server, see Section 2.2.4 Adding Devices by IP Server.

9.2 Configuring Video Wall Settings

Purpose:

After the decoding device is added successfully, the parameters of Video Wall need to configured for

video display.
Steps:
1. Open the Video Wall page.
2. Click Enter Video Wall Config to enter the Video Wall Configuration interface.
3. Thereis a 3*3 video wall on the screen by default. You can add a new video wall if needed.
Perform the following steps to add a new video wall:
1) Click the icon in the toolbar to open the Add Video Wall dialog box.
2) Input the nickname, the number of rows and columns of the video wall.
3) Click Add.
Video Wall Name: [ ]
Row: 3
Column: 3
Add Cancel
To modify the video wall, select the video wall, and click the icon in the toolbar.
To delete the video wall, select the video wall, and click the icon & in the toolbar.
4. Click-and-drag the decoding channel on the left-side list to the display window of video wall, to
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connect them one-to-one correspondence. You can click . in the upper-right corner of the
display window to release the connection.

Notes:

® Up to 4 video walls can be added to the client software.

® The total number of the display windows on the video wall should be no more than 100.

® The ranges of the row number and column number are both between 1 and 20.
Decoding Output Default Video Wall
Search.

- @ Decoding Device

Decoding Device:V... | Decoding Device:V...

B vea2
B veas
B vead
B Bne 1
B BN 2
Boncs
B oenca
B encs
B enecs
B sncy
B Bncs

£E8 Backto Operation Page

9.3 Displaying Video on Video Wall

Purpose:

After the settings of the video wall are configured, the video stream from the cameras can be decoded

and displayed on the Video Wall.

Steps:

1. Click Back to Operation Page to go back to the Video Wall Operation interface.

2. Select the screen layout mode for the display window and click the icon E to save.

3. Click-and-drag the camera from the left-side list to the display window on the video wall.
The video stream from the camera will be decoded and displayed on the Video Wall. Click the
icon ™ and you can get a preview of the video in the lower-right corner of the screen.

Camera Default Video Wall

Search

48]

_J Decoding Device
5 & pet Decoding Device:V... | Decoding Device:V...
@ IPC1_Cameral

- S pc2
@ IPC2_Cameral

- JIDWR
& DVR_Camera2
@ DVR_Camera3
@ DVR_Camera4
@ DVR_Cameras
& DVR_Camerab
@ DVR_Camera?
@ DVR_Camera8
@ DVR_Camera9
@ DVR_Camera0
@ DVR_Cameratl

Layout

)‘>>,

Third Party Devices
PTZ

£5R, Enter Video Wall Confi

67



User Manual of EZ-iVMS

Chapter 10 Web Browsing

Purpose:
The iVMS-4200 client software can also be accessed through web browsing. It provides the
functionalities of live view, playback, device management, account management, system configuration,

etc.

10.1 Login

Steps:

1. Input the IP address of the PC running the iVMS-4200 in the address bar of the web browser, and
press the Enter key. A login window will pop up.

2. Input the user name and password of iVMS-4200.

3. Optionally, check the checkbox Remember password to save the password.

4. Click Login.

Note: You can set the language as Chinese or English in the upper-right corner of the login interface.
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10.2 Device Management

Purpose:

Before doing any operations via the web browser, devices need to be added to the system for

monitoring and management. You can add devices through the web browser.

Adding the Encoding Device

Steps:

1.

Click the Device Management tab to open the Device Management page.

Click the Server tab.

Click Encoding Device to enter Encoding Device Adding interface.

2
3.
E

Sever @ Group
Organization

ﬁ storage server
Bl Stream Media Server

Add New Device Type

Device for Management (1)

Add Device Modify
Nickname = |IP

NVR. 10.1.10.111

Delete Remaote Confi... Refresh All Filter

Device Serial Mo,

NVR208P80820130719BBRR427714216WCVU

Resource Usa... | HDD Status

Recording

=]

You can add the encoding device in the following ways:

Adding Devices Manually.

Adding Devices by IP Segment.

Adding Devices by IP Server.
Adding Devices by HiDDNS.

Adding Devices Manually

Steps:
1. Click the icon to open the device adding dialog box.
2. Select IP/Domain as the adding mode from the drop-down list.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Address: Input the device’s IP address or domain name.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
5. Click OK to add the device.
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Add Offline Device

Adding Mode IP/Domain -
Nickname I

Address

Port 4000

User Mame

Password

+ Exportto Group
Set the device name as the group name and add all the channels connected to the

device to the group.

Adding Devices by IP Segment

Steps:
1. Clickthe " icon to open the device adding dialog box.
2. Select IP Segment as the adding mode from the drop-down list.
3. Input the required information.
Start IP: Input a start IP address.
End IP: Input an end IP address in the same network segment with the start IP.
Port: Input the device port number. The default value is 8000.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device IP. All the
channels of the device will be imported to the corresponding group by default.
5. Click OK, and the device of which the IP address is between the start IP and end IP will be added

to the device list.

Add Offline Device

Adding Mode IP Segment -
Start IP

End IP

Port 4000

User Mame

Password

+ Exportto Group

Create group with device IP.
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Adding Devices by IP Server
Steps:
1. Clickthe "' icon to open the device adding dialog box.
2. Select IP Server as the adding mode from the drop-down list.
3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address: Input the IP Server address.
Device ID: Input the device ID registered on the IP server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.
4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.
5. Click OK to add the device.

Add Offline Device

Adding Mode IP Server -

Nickname I

Server Address

Device ID.

User Name

Password

+ Exportto Group
Set the device name as the group name and add all the channels connected to the

device to the group.

B T

Adding Devices by HIDDNS

Steps:

1. Clickthe "' icon to open the device adding dialog box.

2. Select HIDDNS as the adding mode from the drop-down list.

3. Input the required information.
Nickname: Edit a name for the device as you want.
Server Address:
Device Domain Name: Input the device domain name registered on the HiDDNS server.
User Name: Input the device user name. By default, the user name is admin.
Password: Input the device password. By default, the password is 12345.

4. Optionally, you can check the checkbox Export to Group to create a group by the device name. All
the channels of the device will be imported to the corresponding group by default.

5. Click OK to add the device.
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Note: Check the checkbox Add Offline Device, input the required information and the device channel
count, and then click Add. When the offline device comes online, the software will connect it

automatically.

The devices will be displayed on the device list for management after added successfully. You can
check the nickname, IP address, serial No., HDD status, recording status and other information of the
added devices on the list.

Click Refresh All to refresh the information of all added devices. You can also input the device name in
the filter field for search.

Select device from the list, click Modify/Delete, and then you can modify/delete the information of
the selected device.

Select device from the list, click Remote Config, and then you can do some remote configurations of

the selected device if needed.

Importing Devices to Groups

Purpose:

After the devices added successfully, you can import the devices into groups for a convenient
management.

Steps:

Open the Device Management page.

Click the Group tab to enter the Group Management interface.

Click Add Group to open the Add Group dialog box.

Input the group name and click OK to create a new group.

Click Import to enter the Import Device interface.

Select the encoding channels from the device list and then select a group from the group list.

No vk wbhe

Click Import Select to import the selected encoding channels to the group.

You can also click Import All to import all the encoding channels to a selected group.
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Encoding Channel

Select device | All v
Encoding Channel Add Modify:.s Delete
5 P
172.10.10.180 + 172.9.4.222
172107441 +|- max
172.10.38.180 + EncodeSysiem36
172.9.4.42 + 172.10.10.180
1729645 +|- 172107141
172.9.6.88 + 172.9.4.43
Add group x 172.10.10.123 Import Select ==

17294222
EncodeSystem_96 Import All ==

EncodeSystem_97

EncodeSystem_98

A FEEFEFERFRFGERBRFEE

EncodeSystem_99

BN TR —

Click Add, and you can add a new group to the group list.

Click Modify after selecting a group/camera, and you can modify the group/camera information.
Click Delete after selecting a group/camera, and you can remove all cameras/the selected camera
from the group.

To delete a group, select the group from the list on the Group Management interface and click the

Delete Group button

10.3 Live View

Purpose:

On the Live View page, you can view the live video of the added cameras and do some basic
operations, including picture capturing, recording, PTZ control, etc.

Before you start:

A camera group is required to be defined for live view.

Click the Live View tab to open the Live View page.

Camera 53

P

17294222

max
EncodeSystemas
172.10.10.180
172107141
1729443

% [+ [+ [+ [+ [+

PTZ Control

»  »

Video Settings

73



User Manual of EZ-iVMS

Starting Live View

Steps:

1. Open the Live View page.

2. Optionally, click the ﬁ icon in the live view toolbar, and select the screen layout mode.
3. Click-and-drag the camera to the display window,

or double-click the camera name after selecting the display window to start the live view.

wil LIV ATRITE-

Live View Toolbar:
=18 LREREINSEIES CIENES
On the Live View page, the following toolbar buttons are available:

Set the screen layout mode. 4 types of screen layout modes are

[&s] Set View
selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.
u > Stop/Start Live View  Stop/Start the live view of all cameras.
Capture Capture the picture in the live view process.
o % Start/Stop Recording  Start/Stop the manual recording. The record file is stored in the PC.
4= Previous Go for live view of the previous page.
= Next Go for live view of the next page.
g2 M)  Mute/Audio On Turn off/on the audio in live view
@ @  Digital Zoom Enable/Disable the digital zoom function.
= Full Screen Display the live view in full screen mode. Press ESC to exit.

PTZ Control Functionality

Purpose:
Cameras with the pan/tilt/zoom functionality can be controlled through the web browser. You can also

set the preset, patrol and pattern for the cameras.

Clickthe © icon to expand the PTZ Control panel on the Live View page.

74



User Manual of EZ-iVMS

PTZ Control ¥

= E e @ I
Preset Pattern Patrol
Preset1
Preset?
Preset3
Presetd
Presets

Preset6

Configuring the Preset
Perform the following steps to add a preset:
1. Click the Preset button to enter the PTZ preset configuration panel.

2. Click the direction buttons to steer the camera to the desired view.

3. Select a PTZ preset number from the preset list and click the icon .

To call a configured preset, select the preset from the list and click the icon E

To delete a configured preset, select the preset from the list and click the icon ﬂ
PTZ Control ¥

“E e @ &

Preset Pattern Patrol

Preset1 (> g 3

Preset2
Preset3
Presetd
Presets
Preset6

Configuring the Pattern

1. Click the Pattern button to enter the PTZ pattern configuration panel.
2. Click 0 to start recording of this pattern path.

3. Use the direction buttons to control the PTZ movement.

4. Click 0 to stop and save the pattern recording.

5

Click the icon > to call the pattern. To stop calling the pattern, click .
Note: Only one pattern can be configured, and the newly-defined pattern will overwrite the previous
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pattern.

PTZ Control z

ZE e »
Preset Pattem| Patrol

P 5 QL

Configuring the Patrol

Before you start:

Two or more presets for one camera need to be added.

Perform the following steps to add and call a patrol:

Click the Patrol button to enter the PTZ patrol configuration panel.

Select a track number from the drop-down list.

Click to add a preset, and set the dwell time and patrol speed for the preset.

Repeat the above operation to add other presets to the patrol.

Optionally, you can click & or < to edit or delete the preset in the patrol path.

o v Hw e

Click the icon > to call the patrol. To stop calling the patrol, click .
Notes:

® Up to 16 patrols can be configured.

® The preset dwell time can be set to 1~255 sec, and the patrol speed can be set to level 1~40.

PTZ Control z

- \_/ -

2 E e @ I

Preset Pattern Patrol | Add Patrol No.
Path1 ~ p E &

Preset Preset1

Dwell Time(s)

Patrol speed
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Video Settings Functionality

Purpose:

The video parameters, including the brightness, contrast, saturation and hue, can be configured to
create better visual effects.

Steps:

1. Clickthe © icon to expand the Video Settings panel on the Live View page.
2. Move the slider to adjust the brightness, contrast, saturation or hue of the live video.

3. Click Default Value, and you can restore the defaults of the video parameters.

Video Settings

Brightness
Contrast

Saturation

Default Value

10.4 Playback

Purpose:
The record files stored on the storage devices such as the HDDs, Net HDDs and SD/SDHC cards on the

local device can be searched and played back remotely through the web browser.

Click the Playback tab to open the Playback page.
Camera 8 Playback } ., Search Results

IrC1

@& IPC1_Camerat
PC2
DVR
IP Dome
From 2013-05-02 00:00:00 ﬁ
To 2013-05-02 23:59:59 E
By card number
File Type
Al
Q search
Playback Toolbar:
B ] o do

On the Playback page, the following toolbar buttons are available:
@ Set View Set the screen layout mode. 4 types of screen layout modes are
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selectable: 1-Screen, 4-Screen, 9-Screen and 16-Screen.

u Stop/Start Playback Stop/Start the playback of all channels.

Capture Capture the picture in the playback process.

O % Start/Stop Clipping Start/Stop clipping the record files.

g2 d)  Mute/Audio On Turn off/on the audio in playback.

= Full Screen Display the playback in full screen mode. Press ESC to exit.

Searching Record Files

Steps:

1. Open the Playback page.

2. Select the cameras to be searched from the list.

3. Click the icon ﬂ to specify the start time and end time for the search.

4. Click Search. The record files of the selected cameras will be displayed on the Search Result tab
page.

Notes:

® You can also search the record files by the card number (only applicable to ATM DVR) or by the
file type.

® Up to 16 cameras can be searched simultaneously.

= Playback [ Search Results ‘
File List Q
Index Camera Start Time End Time Record Type File Size Play
1 172107441 Cameral  2013-05-10 00:00:00 2013-05-10 00:00:01 Time oMB (]
2 172107441 Cameral  2013-05-10 00:00:02 2013-05-10 032655 Time 173ME (]
3 72107441 _Cameral  2013-05-10 03:26:55 2013-05-10 08:30:14 Time 254MB o
4 172107441 Cameral  2013-05-10 08:30:14 2013-05-10 11:26:21 Time 143MB (]
5 172107441 Camera2  2013-05-10 00:00:00 2013-05-10 00:00:01 Time oMB (]
6 172107441 _Camera 20130510 00:00:02 2013-05-10 04:32:27 Time 234Me Q
7 172107441 Camera2  2013-05-10 043227 2013-05-10 09:28:33 Time 254MB (]
8 172107441 Camera2  2013-05-10 09:28:33 2013-05-10 11:26:34 Time 101MB (]
9  172.10.74.41_Camera3 2013-05-10 00:00:00 2013-05-10 00:00:02 Time oMe >}
10 172107441_Camera3  2013-05-10 00:00:02 2013-05-10 04:31:21 Time 27MB o
11 172107441 Camera3  2013-05-10 04:31:21 2013-05-10 09:35:47 Time 254MB8 [*]
12 172107441 Camera3  2013-05-1009.35:47 2013-05-10 1125:45 Time 92MB (]
13 172107441 Camerad  2013-05-10 00:00:00 2013-05-10 00:00:02 Time ovB o
Total 17 records <</[<|1]>]>>| Page >

Playing Back Record Files

After searching the record files, you can play back the record files in the following two ways:
® Playback by File List

Select the record file from the search result list, and then click the icon % to play the video on
the display window of playback.
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I «» p»

®  Playback by Timeline
The timeline indicates the time duration for the record file. Click on the timeline to play back the

video of the specific time.

You can click E==3 or L=== to scale up or scale down the timeline bar.

You can use the mouse wheel to zoom in or zoom out on the timeline.

8 Playback . Search Resulls

He «wer i

Windowd1 | I J*

Window(2
Window(3
Window(4

Move the mouse pointer to the display window in playback to show the toolbar.
Toolbar in Each Playback Display Window:
I e «» » I

In each playback display window, the following toolbar buttons are available:

i p Pause/Start Playback  Pause/Start the playback of the record files.

m Stop Playback Stop the playback of all cameras.

“ Speed Down Decrease the playback speed of the record files.
b Speed Up Increase the playback speed of the record files.
> Single Frame Play back the record files frame by frame.

& Download Download the record file for backup.
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10.5 Account Management

Purpose:

Different user accounts can be added for the client through the web browser and you can also assign

permissions for the added users. The user you registered is set as the super administrator.

Click the Account Management tab to open the Account Management page.

User List

Index

Adding the User

Steps:

No ok wbhe

Notes:

1

Open the Account Management page.
Click Add to open the Add User dialog box.

Select the user type. You can set the user type as Administrator or Operator.

Click Save to save the settings.

 Add

User Name

Modify

.4 Delete

User Type

Super User

Input the user name, password and confirm password as desired.

Check the checkboxes to assign the permissions for the created user.

Optionally, you can click Default Permission to restore the default permissions of this user.

® A user name cannot contain any of the following characters: /\ : * ? “ <> |. And the length of the

password cannot be less than 6 characters.

® Up to 50 user accounts can be added for the client software.

Add User

User Infomation

User Type Administrator

Password

User Privilege

4

<

LN N SRR N U U U Y

Al

Live View

PTZ Control

Capture

Record

Camera Settings

Playback remote record file(s)
Download remote record file(s)
Remote Recording

Two-way Audio
Synchronization

Picture backup

Backup Record File(s)

User Name

Confirm Password

< IPC1
+ IPC1_Cameral
v IPC2
¥ IPC2_Camerat
~ DVR
+ DVR _Cameral
+ DVR_Camera2
+ DVR_Camera3
+ DVR_Camerad
~ DVR_Camerab
+ DVR_Camerab
« DVR _Camera?
+ DVR_Camera8
+ DVR_Camerad

[ e

m
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Managing the User

Purpose:

The newly created user account is added to the user list. You can edit or delete the information of the
user accounts.

To edit the information of the user, select the user from the user list, and click Modify.

To delete the information of the user, select the user from the user list, and click Delete.

10.6 System Configuration

Purpose:
The general parameters, including network performance, play performance and saving paths of files

can be configured through the web browser.

Click the System Configuration tab to open the System Configuration page.

Network Performance Normal Better @ Best

Play Performance Real Time v
Saving Path of Video File ChUsers\zhangxiu\BSWeb\Wideo

Saving Path of Pictures ChUsers\zhangxiu\BSWeb\Capture

Saving Path of Configuration File  C:\Users\zhangxiu\BSWeb\Config

Default Value Save
Steps:
1. Open the System Configuration page.
2. Set the network performance and play performance. Click the icon | to select a local saving

path for the files. For details, see Table 10.1 System Parameters.
Optionally, you can click Default Value to restore the defaults of all system parameters.
4. Click Save to save the settings.
Table 10.1 System Parameters

Parameters Descriptions

Network Performance | The current network conditions. It can be set as Normal, Better or Best.

The play performance of the live video. It can be set as Shortest Delay, Real
Play Performance )
Time, Balanced or Fluency.

Saving Path of Video The saving path of video files recorded by manual recording.

Files

Saving Path of Pictures | The saving path of the captured pictures in live view or playback.

Saving Path of The saving path of the system configuration files.

Configuration File
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Troubleshooting

Live View

Problem:

Failed to get the live view of a certain device.

Possible Reasons:

®  Unstable network or the network performance is not good enough.

® The device is offline.

® Too many accesses to the remote device cause the load of the device too high.

® The current user has no permission for live view.

® The version of the client software is below the needed version.

Solutions:

®  Check network status and disable other not in use process on your PC.

®  Check the device network status.

®  Restart the device or disable other remote access to the device.

® login with the admin user and try again.

® Download the client software of the latest version.

Recording

Problem:

® Local recording and remote recording are confused.

Solutions:

® The local recording in this manual refers to the recording which stores the record files on the
HDDs, SD/SDHC cards of the local device.

® The remote recording refers to the recording action commanded by the client on the remote
device side.

Playback

Problem:

® Failed to download the record files or the downloading speed is too slow.

Possible Reasons:

Unstable network or the network performance is not good enough.
The NIC type is not compatible.

Too many accesses to the remote device

The current user has no permission for playback.

The version of the client software is below the needed version.

Solutions:

Check network status and disable other not in use process on your PC.

Directly connect the PC running the client to device to check the compatibility of the NIC card.
Restart the device or disable other remote access to the device.

Log in with the admin user and try again.

Download the client software of the latest version.
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